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Creating a Teamsite 

A teamsite comes with announcements lists, discussion  boards, document libraries, a calendar, a 

links list, a wiki page library, and a task list already configured and ready for use.  These 

components of the site allow you and your team to quickly set up and begin collaborating on 

your projects. 

 

Create a Site based on a Template 

1. Click on the Site Actions menu and select New Site. 

2. Click on any site icon and notice that on the right side of the window the creation 

attributes are dynamically displayed for each item. 

3. Click on Team Site to select it then click on More Options. 

 

 
 

4. Enter a title and description for the site. 

5. Enter a URL for the site.  NOTE:  When entering the URL you only need to specify what 

the site name (last portion of the URL) will be.  SharePoint will automatically generate 

the first portion of the URL.  Keep the URL short do not use spaces, use hyphens instead. 

6. If you do not want the site to inherit permissions from the parent site click Use unique 

permissions. 

7. Select whether or not you would like the site to appear on the Quick Launch of the parent 

site. 

8. The new site can inherit the top link bar from the parent or have it’s own. 

9. Click Create.  
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Permissions 

By selecting Use unique permissions, the Set Up Groups for this Site window will appear.  Use 

this page to specify who can access your site.  You can create new SharePoint groups or re-use 

existing SharePoint groups. Note: Best Practice for granting permission to users is to add them 

to a SharePoint group, not to give the user access directly to a site.  It is much easier to maintain 

groups across multiple sites than to maintain individual users across multiple sites. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Visitors to this Site:  create a group of visitors or re-use an existing SharePoint group.  To 

use an existing group click on the down arrow and select from the list. To see a complete 

list of groups click on More… 
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2. Members of this Site:  a new group is automatically created for this group.  You can add 

members to this group by typing in the user’s name or clicking on the address book icon

.  Separate each user’s name with a semicolon. 

 

3. Owners of this Site:  a new group is automatically created for this group.  You can add 

members to this group by typing in the user’s name or clicking on the address book icon.  

Separate each user’s name with a semicolon.  Permissions are cumulative, therefore if 

you add someone to the Owners group there is no need to add them to the other groups. 

 

4. Click Ok when all of the changes have been made. 

 

To check or make changes to group or individual permissions click on Site Actions and select 

Site Permissions.  From this page you can grant permissions, create new groups, edit or remove 

user permissions.   

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Edit User Permissions:  check the box next to the group or individual name that you 

would like to make the changes to and click on Edit User Permissions.  Select the new 

permission level and click Ok. 
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2. Remove User Permissions:  check the box next to the group or individual name that you 

would like to remove all permissions for.  A warning window appears, click Ok to 

remove permissions. 

 

 
 

3. Add or Remove Individuals from a Group:  click on the group name, click the New drop 

down menu and select Add Users 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Enter the user name.  You can enter more than one user name, separate the names with a 

semicolon.  Click Ok when finished. 
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5. To remove a user from a group, click on the group name check the box next to their name 

and click on the Actions pull down menu.  Select Remove Users from Group, a warning 

window will appear, click Ok. 

 

 
 

 

6. Grant Permissions:  to add individual users or groups to a site click on Grant Permissions.  

Enter the user names or group names, remember to separate them with a semicolon.   

Select which SharePoint group the user should be added to or grant them permissions 

directly by selecting Grant users permission directly.  Click Ok when finished. 
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7. Create Group:  to create a new group click on Create Group, enter the group name, 

description and select a permission level.  Click Create when finished. 

 

 

 
 

 

Check Permissions Tool 
New to SharePoint 2010 the Check Permission tool will evaluate what permission a particular 

user or group has.  To view the permission levels: 

 

1. Click on the Site Actions pull down menu and select site permissions. 

2. Click on the Check Permissions icon on the Ribbon. 
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3. Enter the username or group name and click Check Now.  A window will appear listing 

all the persmissions for that particular user or group. 

 

 
 

 

Edit Page 
The Edit Page option is used to change the site image, the welcome text or add new lists to the 

page.  To begin editing click the Edit button  located to the right of the Site Actions drop 

down menu on the Ribbon or click on Site Actions and select Edit Page.  

 

Change the Site Image:   

1. Click the Edit Button. 

2. Click on the picture to highlight it. 

3. Click on the  Picture Tools tab that appears on the Ribbon. 

4. Select the Change Picture icon. 

5. Select the location to upload the picture from; either from you computer or from the web. 
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6. If you select a picture stored on your computer it will upload to your Site Assets library 

or one of the other site libraries.  Select which library to upload the picture to by clicking 

on the down arrow.   

Asset Library:  An asset library is a document library that is specially designed to store 

digital assets such as images, audio files, and videos.  This kind of library can be used as 

a repository for media files that will be used throughout the SharePoint environment, for 

example corporate logos, training videos, etc. 

 

 
 

7. When you are finished making your changes click on the Save & Close icon. 

 

 
 

8. You can also click on the Save & Close icon that has more options.  From here you can: 

o Save and Close 

o Save and Keep Editing 

o Stop Editing 

 

 
 

 

Remove the Getting Started Links 

1. Highlight all the links .  Notice the Table Tools tab that appears on the Ribbon.  The 

getting started links are a table. 
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2. Click on the Layout tab under Table Tools and click on the Delete icon.  Click Delete 

Table. 
 

 
 

 

3. Highlight the text Getting Started and hit the backspace key to delete the text. 

4. Click Save and Close before exiting the page. 

 

 

Content Editor 

1. Highlight the text to edit and select the font and size from the Format Text tab.  

Additional formatting options are located on the Ribbon. 

 

 
 

2. Click Save and Close before exiting the page. 
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Web Parts: A web part is an aggregation of information from other sources which can be 

displayed on a page.  Web parts can display many types of data, including lists, libraries and 

other web pages. 

 

Adding a Web Part 

1. Click on the page where you would like to insert a web part. 

2. Click on the Insert tab located under the Editing Tools tab to activate the Ribbon. 

3. Select the Web Part icon on the Ribbon to display the web part choices. 

 

 
 

4. Highlight the web part and click Add to insert it onto the page. 

 

Removing a Web Part:  when you remove a web part you are not deleting the information 

contained within the web part, you are only removing the link to it. 

 

1. To remove a Web Part, such as the Shared Documents library shown in the example 

below, click to highlight it this will activate the Web Part Tools tab on the Ribbon. 

2. Click on the Web Part Tools tab and select Delete. 
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Drag and Drop Web Parts on a Page 
1. Click the Edit button on the ribbon to begin editing the page. 

2. Click on the title of the web part that you would like to move. 

 

 
3. Drag it to the new location and release the mouse. 

 

 
 

4. Announcements is now located below the Shared Documents web part. 

 

Creating Links 
Creating a hyperlink 

1. Click on the Edit page icon located on the ribbon. 

2. Highlight the text you would like to turn into a hyperlink. 

3. Click on the Insert tab located under Editing Tools on the ribbon. 

4. Click on the Link icon. 
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5. Enter the URL address in the Insert Hyperlink box and click OK. 

6. Once you created the hyperlink the Link Tools tab will appear on the ribbon. 

7. You can add a description for the link, have it open in a new tab and display an icon. 

 

 
 

8. To delete the hyperlink click Remove Link located on the Link Tools ribbon. 

 

Creating a document link 
1. Open the library that contains the document you wish to create a link for, right click on 

the document and select copy shortcut. 

2. Click on the Edit button. 

3. Type the text on the page where you would like the link to appear. 

 
 

4. Highlight the text that will become the link. 

5. Click on the Insert button. 

6. Click on the Link icon. 

7. Paste the URL into the Link box. 

8. Click Ok. 

9. Click the Link Tools tab, enter a description and check the Open in new tab option if you 

would like the link to open in its own window. 
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Create a link using Double Brackets 
Links can be created to pages and lists within a teamsite by using double brackets instead of the 

link icon. 

Creating a link to a Page 

1. Click the Edit button to begin editing. 

2. Place the cursor where the link should appear. 

3. Type double brackets, [[, SharePoint shows the pages within the teamsite that a link can 

be created for. 

 
 

4. Select an item by using the down arrow, hit enter. 

5. SharePoint will automatically add the 2 closing brackets. Note: if you would like a larger 

font for the link, change the font size before you start typing. 

 
 

6. Click Save and Close, the link becomes active. 

 

 
Creating a link to a List 

1. Follow steps 1through 3 from the section above. 

2. Select List from the list of options. 

3. The word list appears inside double brackets. 

4. Type the name of the list that you would like to link to after the semicolon.  For example, 

Announcements, Calendar, Team Discussion, etc.  
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5. You can insert descriptive or alternate text for the list link if you want a name other than 

the list name. 

6. Insert a pipe symbol ( | ) after the word Calendar and add the text Team Calendar, there 

are no spaces before or after the pipe sign. 

 
7. Click Save and Close for the link to become active. 

 

 
 

 

Changing the Text Layout 
There are several design options to choose from for the page layout. Note: You will not lose any 

content when you change the text layout of the page. 

1. Click on the Edit button to begin editing the page. 

2. Click on the Text Layout drop down menu. 

3. Select the option that best suits your needs. 

 

 
 

4. Save and Close the page when you are finished. 

 

 

 

 

The descriptive list link 
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Customizing the Quick Launch Bar 
 

Adding a New Navigation Link 

Note: best practice for creating new links is to have the URL at hand prior to adding the link.  

We will demonstrate how to add a library link. 

a) Go to All Site Content to find the library you would like to add to the Quick Launch bar. 

b) Right click on the library name and go to properties. 

c) Copy the URL of the library except for the  /Forms/Allitems.aspx  portion. 

 

 
d) Close the window. 

 

1. Click on the Site Actions drop down menu and go to Site Settings. 

2. Under the Look and Feel category click on Navigation. 

3. Scroll down to the Navigation Editing and Sorting section. 

4. Under the Current Navigation section click on the heading where you would like to add a 

link.  In this example we will add a library under the Libraries section. 
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5. Click on Add Link. 

 
6. Type a title for the link in the Title box. 

7. Paste the URL into the URL box. 

8. Click Ok. 

 

 
 

9. The name of the Library will appear in the Library list. 

10. Scroll to the bottom of the page and click Ok. 

 

Delete a Navigation Link 
1. Click on the Site Actions drop down menu and select Site Settings. 

2. Under Look and Feel click on Navigation. 

3. Click on the link that you would like to delete. 

4. Click Delete.  Note: this does not delete the library, only the link is deleted. 

 

 
 

5. Scroll down to the bottom of the page and click OK. 

 

Adding a New Heading 
Note: best practice for creating a new heading is to have the URL at hand prior to adding the 

link.  We will demonstrate how to add the People and Groups heading. 

a) In Site Settings under the Users and Permissions group right click on People and Groups. 

b) Go to Properties. 

c) Copy the entire URL. 
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d) Close the window. 

 

1. From the Site Actions drop down menu select Site Settings. 

2. Under Look and Feel select Navigation. 

3. Click on Current Navigation to select it. 

4. Click on Add Heading. 

 
 

5. Type People and Groups into the description box. 

6. Paste the URL into the web address box. 

7. Click Ok. 

 

 
 

8. Scroll down to the bottom of the page and click Ok. 
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Delete a Heading 

1. Click on the Site Actions drop down menu and select Site Settings. 

2. Under Look and Feel click on Navigation. 

3. Click on the heading that you would like to delete. 

4. Click Delete. 

 

 
 

5. Scroll to the bottom of the page and click Ok. 

 

Change Order in the Quick Launch bar 
You can change the order of how items appear in the Quick Launch bar. 

 

1. Click on the Site Actions drop down menu and select Site Settings. 

2. Under Look and Feel click on Navigation. 

3. Click on the link or heading that you would like move up or down. 

4. Click on the Move Up or Move Down option. 

 

 
 

5. Scroll down to the bottom of the window and click Ok. 

 

 

 

 

 

 

 



19 
 

Customizing the Top Link Bar 

Note: If a site is renamed from the Title, Description, and Icon page, the site name is not updated 

on the top link bar. To change the name that appears on the top link bar, you must edit the top 

link bar. 

 

Adding a Link to the Top Link Bar 
1. On the Site Actions menu, click Site Settings. 

2. In the Look and Feel group, click Navigation. 

3. If the site is displaying the same navigation links as the parent site the Global Navigation 

option will not be visible in the Navigation Editing and Sorting section. 

4. To activate the Global Navigation option, click on Display the navigation items below the 

current site. 

 

 
 

5. Scroll down to the Navigation Editing and Sorting section. 

6. Click on Global Navigation. 

7. Click on Add Heading or Add Link and follow the same steps as described above in the 

Quick Launch section. 

8. To reorder or delete links follow the same steps as described above in the Quick Launch 

section. 

9. To display the same navigation links as the parent site, click on Display the same 

navigation items as the parent site.  The navigation links that you added will disappear. 

10. Scroll down to the bottom of the page and click Ok. 
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Recycle Bin 

Each site has a recycle bin from which deleted items can be restored; items such as documents, 

list items and libraries.  Note:  deleted items that are more than 30 days old will be automatically 

emptied. 

 

1. Click on the Recycle Bin link located at the bottom of the Quick Launch bar. 

2. Check the box next to the item or items that you would like to restore and click on 

Restore Selection. 

 

 


